ImPressOne: A Pressure Display and Acquisition Program for the Low Speed Wind Tunnel at DSTO

Adam Blandford

Air Vehicles Division
Defence Science and Technology Organisation

DSTO-GD-0486

ABSTRACT

DSTO operates a low speed wind tunnel within the Air Vehicles Division of DSTO Melbourne. Airspeeds up to approximately 100 m/s can be produced in the empty test section which is 2.7 m wide by 2.1 m high. Acquisition and display of pressure distribution data over a model under test in the wind tunnel is important to the project manager and test engineer so they can monitor the results in near real time as the test progresses. A software package called ImPressOne was developed for this purpose giving a graphical display of the pressure and the ability to acquire pressure sets and save the data to file. This document provides details of the software and its operation. It also provides information on programming and development considerations of the software.

RELEASE LIMITATION

Approved for public release
ImPressOne: A Pressure Display and Acquisition Program for the Low Speed Wind Tunnel at DSTO

Executive Summary

Measuring the pressure distributions on the surfaces of models of vehicles and through their wake is one of the major functions of the Low Speed Wind Tunnel (LSWT) operated by the Defence Science and Technology Organisation (DSTO). The pressure distribution data acquired are needed for the evaluation, design and research of military aircraft, missiles and air vehicles in general, and for assessment of their performance.

The LSWT utilises a Pressure Systems (previously known as Pressure Systems Incorporated) System 8400 (PSI8400) for its pressure acquisition measurements. A software package called ImPressOne has been developed as part of the Data Acquisition System in the LSWT and it is responsible for communicating with the PSI8400 and displaying and acquiring the pressure data for the model under test.

ImPressOne has been developed in the Microsoft Visual C#.NET programming language to provide the user with graphical displays of measured pressure data. This has created a user-friendly environment and it has enabled faster and easier monitoring of wind tunnel results both qualitatively and quantitatively in near real time. With this interface, any abnormality of the data can be noticed immediately. The test engineer can then decide if the test sequence needs to be altered or the data point needs to be re-acquired. Malfunctioning of the test equipment can also cause abnormalities and they can be rectified immediately. Real-time display of acquired data is an important tool and an integral part of the data acquisition system for the DSTO wind tunnels, and the software developed could have application to other test cells that use a similar pressure measurement system.

The new software has achieved all its design specifications and has proved to be successful as it provides the test engineer with a means for monitoring test results as the test progresses. It also extends the capability of DSTO to obtain low-speed aerodynamic data with improved accuracy and efficiency.
Adam Blandford
Air Vehicles Division

Adam Blandford graduated from the Royal Melbourne Institute of Technology in 2000 completing a Bachelor of Engineering (Aerospace) with First Class Honours. The following year he obtained employment with the Defence Science and Technology Organisation at Melbourne. Working in Flight Systems, he has gained experience in the area of wind tunnels and experimental aerodynamics. Recently he played a major role in the F-111/AGM-142 store clearance project in the Transonic Wind Tunnel, and he has made significant contributions to the JDAM-ER tests in this tunnel. He has also been involved in improvements to the wind tunnel data acquisition systems and the development of test techniques.
Contents

1. INTRODUCTION ............................................................................................................... 1

2. FUNCTION AND FEATURES OF THE PROGRAM ................................................... 2

3. HARDWARE CONFIGURATION AND SOFTWARE DEVELOPMENT ........ 5
   3.1 GPIB Configuration ................................................................................................. 5
   3.2 PSI8400 Native Commands .................................................................................. 6
   3.3 Printer Configuration ............................................................................................ 6
   3.4 Installation Directory Structure ......................................................................... 6
   3.5 Publishing Pressure Data to the Network ........................................................... 7

4. IMPRESSONE INTERFACE ........................................................................................... 8
   4.1 Toolbar ................................................................................................................... 8
   4.2 Main Menu ............................................................................................................. 11
   4.3 Status Bar .............................................................................................................. 16

5. IMPRESSONE TESTPLAN ............................................................................................ 17
   5.1 Test Title and Description .................................................................................. 18
   5.2 PSI8400 Configuration ....................................................................................... 19
   5.3 Saving the ImPressOne Testplan ......................................................................... 27

6. PSI8400 INITIALISATION ........................................................................................... 28

7. PSI8400 CALIBRATION ............................................................................................... 30
   7.1 Full Calibration ..................................................................................................... 31
   7.2 Zero-Offset Calibration ....................................................................................... 32
   7.3 Calibration Configuration Settings ..................................................................... 33
   7.4 Save Calibration Data ......................................................................................... 33
   7.5 Open Calibration File ......................................................................................... 34

8. IMPRESSONE REAL-TIME PRESSURE MONITORING ......................................... 34
   8.1 Start/Stop Real-Time Scan .................................................................................. 34
   8.2 Edit Visible Port Groups ..................................................................................... 34
   8.3 Plot Pressure Coefficients/Values ..................................................................... 36
   8.4 Show Cursor ........................................................................................................ 36
   8.5 Show Legend ........................................................................................................ 37
   8.6 Show Windspeed ................................................................................................. 37
   8.7 Interacting with the Pressure Chart .................................................................. 38

9. IMPRESSONE DATA ACQUISITION ......................................................................... 39
   9.1 Save Test Data File .............................................................................................. 40
   9.2 New Test Data File .............................................................................................. 40
10. IMPRESSONE OPTIONS

10.1 General Options

10.2 Connection Options

10.3 Chart Options

10.4 Status Options

11. CONCLUSIONS AND FUTURE DEVELOPMENT

12. REFERENCES

APPENDIX A: AN EXAMPLE OF AN IMPRESSONE TESTPLAN FILE

APPENDIX B: PSI8400 EU PRESSURE CONVERSION EQUATIONS

APPENDIX C: AN EXAMPLE OF AN IMPRESSONE CALIBRATION FILE

APPENDIX D: AN EXAMPLE OF AN IMPRESSONE TEST DATA FILE
List of Figures

Figure 1: Screen shot of the main user interface in ImPressOne ________________________ 3
Figure 2: ImPressOne connection to the PSI8400 system _____________________________ 5
Figure 3: ImPressOne installation directory structure ________________________________ 7
Figure 4: DataSocket server diagnostic window ____________________________________ 8
Figure 5: ImPressOne toolbar __________________________________________________ 8
Figure 6: ImPressOne file menu ________________________________________________ 11
Figure 7: ImPressOne edit menu ______________________________________________ 12
Figure 8: Edit system processor date/time form ____________________________________ 12
Figure 9: ImPressOne view menu _______________________________________________ 13
Figure 10: ImPressOne tools menu _____________________________________________ 14
Figure 11: ImPressOne chart menu ______________________________________________ 15
Figure 12: ImPressOne help menu ______________________________________________ 16
Figure 13: ImPressOne status bar ______________________________________________ 17
Figure 14: ImPressOne open testplan form _______________________________________ 18
Figure 15: ImPressOne testplan information form ________________________________ 19
Figure 16: ImPressOne testplan configuration form ________________________________ 20
Figure 17: PSI8400 PCU configuration form ________________________________________ 21
Figure 18: PSI8400 SDU configuration form ________________________________________ 22
Figure 19: Dtc-scanner ________________________________________________________ 23
Figure 20: PSI8400 scanner configuration form ____________________________________ 23
Figure 21: PSI8400 setup table configuration form ________________________________ 24
Figure 22: PSI8400 pressure port group configuration form _________________________ 26
Figure 23: Dynamic pressure scanner port number form ____________________________ 27
Figure 24: Save testplan prompt ______________________________________________ 27
Figure 25: Save testplan file dialogue ___________________________________________ 28
Figure 26: PSI8400 initialisation command list ____________________________________ 29
Figure 27: PSI8400 initialisation warning ________________________________________ 29
Figure 28: PSI8400 initialisation progress ________________________________________ 30
Figure 29: PSI8400 full calibration progress form __________________________________ 31
Figure 30: PSI8400 save calibration data prompt _________________________________ 32
Figure 31: PSI8400 zero-offset calibration result message box ________________________ 32
Figure 32: ImPressOne calibration configuration form _____________________________ 33
Figure 33: Visible pressure port group selection form _____________________________ 35
Figure 34: View port group details display ______________________________________ 36
Figure 35: Cursor use on the pressure chart ______________________________________ 37
Figure 36: Acquiring data progress bar __________________________________________ 39
Figure 37: Data set label prompt ______________________________________________ 39
Figure 38: General options form ______________________________________________ 41
Figure 39: Connection options form ____________________________________________ 42
Figure 40: Chart options form ________________________________________________ 43
Figure 41: Status options form ________________________________________________ 44
1. Introduction

Wind tunnels are one of the primary sources of aerodynamic data for aeronautical research and support. The Australian Defence Science and Technology Organisation (DSTO) owns and operates a number of major wind tunnels and a water tunnel. The Low Speed Wind Tunnel (LSWT) was designed in 1939 and commissioned in 1941. It operates at atmospheric pressure and it has a closed-jet, single-return-circuit. The test section is an irregular octagon, 2.74 m wide, 2.13 m high and 6.56 m long. A single stage, 3.96 m diameter, eight-bladed fan, driven by electric motors with a total power output of 660 kW, provides a wind speed of up to 100 m/sec in the empty test section at a fan rotational speed of 750 revs/min.

Measuring pressure distributions on the surfaces of models of vehicles and through their wake is one of the major functions of the LSWT at DSTO. The pressure distribution data acquired are needed for the evaluation, design and research of military aircraft, missiles and air vehicles in general and for assessment of their performance.

A Pressure Systems System 8400 (PSI8400) was commissioned for use in the LSWT in the 1980s. It's a modular, parallel processing system for high-speed pressure scanning at up to 200,000 measurements per second. It is controlled by a host personal computer (PC) via a GPIB connection. An MS-DOS based program “MCP” was developed in-house on this host as the interface to the PSI8400. This program provided a simplistic real-time display of the pressure data acquired. Any abnormality of the data was immediately noticeable and the test engineer could then decide if the test sequence needed to be altered or the data point needed to be re-acquired. Malfunctioning of the test equipment could also cause an abnormality, in which case it could be rectified immediately. Real-time display of acquired data is an important tool and an integral part of the data acquisition system for the DSTO wind tunnels.

In the late 1990s, the PCs in the LSWT were upgraded and they were based on the Microsoft Windows platform, providing a more user-friendly environment than the MS-DOS-based program, which had become obsolete. To retain the pressure acquisition and display capability, a new software package to interface with the PSI8400 was developed. This was known as “PSIVCP” and was developed using the software development package Hewlett-Packard Visual Engineering Environment (HP-VEE).

In 2004, a Scanner Digitiser Interface configuration for the PSI8400 was implemented. This configuration dramatically enhances the data quality for wind tunnel applications by allowing the use of digitally temperature-compensated scanners (dtc-scanners). It also increases productivity by reducing the frequency of calibrations required. A GPIB to Ethernet converter was also installed in 2004 enabling any PC attached to the LSWT network to communicate with the PSI8400.
By 2004/2005, the PSIVCP interface to the PSI8400 had become increasingly difficult to maintain and it did not have the functionality required for modern wind tunnel pressure data acquisition tests. A new application has been developed to interface with the PSI8400 and is called “ImPressOne”.

This document gives details of this new application, particularly from an operational point of view.

2. Function and Features of the Program

The fundamental requirements of ImPressOne are to:

- Display and monitor, in real time, the pressures acquired by the PSI8400 data acquisition system in the form of an x-y chart, and;
- Acquire the pressure data on the PSI8400 and write it to file.

A typical screen shot of the ImPressOne main user interface is shown in Figure 1. ImPressOne consists of a window with a main menu bar, the ImPressOne toolbar, a status bar, the pressure chart, associated legend and windspeed indicator. The main functionality of ImPressOne can be accessed using the toolbar. Additional functionality is accessed through the main menu. A status bar indicates the current status of the application. The pressure chart displays the near real-time pressures acquired from the PSI8400, the associated legend identifying pressure port groupings. The windspeed indicator displays the windspeed as calculated by a defined dynamic pressure port measurement. To learn about all the functions of ImPressOne and how to access them, refer to Chapter 4.
Before pressures can be monitored or acquired using ImPressOne, four prerequisite steps must have been completed. These are:

1. The PSI8400 must be switched on and connected to the local area network via the GPIB-Ethernet converter.
2. A software communication connection must have been made between the host PC and the PSI8400.
3. An ImPressOne testplan must have been loaded and configured.
4. The PSI8400 must have been initialised according to the configuration defined in the testplan.

The first step must be performed manually by the user. The second step should occur automatically when ImPressOne is started, providing that the PSI8400 is switched on and correctly connected to the network.

The third step must be completed by the user. The testplan contains a test description and also the configuration of the PSI8400. For more details on the ImPressOne testplan, refer to Chapter 5.
Once the testplan is loaded and fully defined, the window in the main user interface is populated with a chart. This chart will show the real-time pressure display once the PSI8400 is initialised. For more details on the PSI8400 initialisation, refer to Chapter 6. Any pressure data that is acquired by ImpressOne is written to an Ethernet data socket on the local network so that other applications may have access to it.

If the configuration is a full Fibre-Optic Interface Unit (FIU) system utilising dtc-scanners, a calibration may not be required as the calibration coefficients can be uploaded from the scanner’s embedded EEPROM. However, if traditional scanners are being used, either a calibration must be performed or the calibration coefficients must be loaded from a previously saved calibration. For more details on PSI8400 calibration, refer to Chapter 7.

If the application is closed at this point and restarted within two hours, the user has the option of restoring the application status to this point without the need to complete these steps again provided no configuration change has been made to the PSI8400.

The pressure chart in the Figure 1 screenshot shows different pressures plotted in groups using different colours as identified by the legend. The user may change which groups he wants visible on the real-time chart through the Chart menu or by right clicking on the chart. This increases or reduces the complexity of what is shown at any given time. This chart may be printed to the default printer. For more details on real-time pressure monitoring, refer to Chapter 8.

By default, pressures are plotted by their actual unit value as defined in the testplan. If desired, the user may choose to plot the pressures as pressure coefficients through the chart menu or by right clicking on the chart.

Pressure data acquisition is achieved by selecting the command on the toolbar or through the Tools menu. This immediately initiates data acquisition according to the setup table parameters defined in the testplan. Once the data acquisition cycle is completed, the user is prompted to enter a measurement set label. This process may be repeated as many times as desired. The user can save the data that has been acquired to file at any time. For more details on ImpressOne pressure data acquisition, refer to Chapter 9.

ImpressOne provides a number of user options that can be modified, such as redefining the GPIB address of the PSI8400 or modifying the connection and initialisation status to allow greater flexibility in operating the equipment. To learn about these options and their effect, refer to Chapter 10.

ImpressOne provides a full online help system which is accessed through the main menu or the toolbar.
3. Hardware Configuration and Software Development

ImPressOne was developed on an IBM-compatible PC running Microsoft Windows XP using Microsoft Visual Studio®.NET™ 2005 in the C#.NET language. Classes from the National Instruments™ add-in package Measurement Studio 8.1 were used to simplify program development. This provided a simple graphical programming environment with a powerful toolset and flexible solution options.

The PC that ImPressOne runs on must have the .NET framework 2.0 or higher installed. It must also have the NI GPIB-ENET driver software (NI-488.2) installed and configured.

3.1 GPIB Configuration

To obtain pressure data, the PC communicates with the PSI8400 data acquisition system using GPIB communication protocols via Ethernet using a National Instruments GPIB-Ethernet converter unit. A diagram of the hardware interface is shown in Figure 2.

![Figure 2: ImPressOne connection to the PSI8400 system](image)

The communication settings are configured in the NI-488.2 driver software. Default configuration settings are:

**GPIB Settings**
- Primary GPIB Board Address: 0
- Secondary GPIB Address: NONE
- I/O Timeout Setting: 1 sec
- Terminate Read on EOS: No
- Set EOI with EOS on Write: No
- Type of Compare on EOS: 7-bit
- EOS Byte: 00H
- Send EOI at end of write: Yes
- Board is System Controller: Yes
- Assert REN when SC: Yes
- Enable Auto Serial Polling: No
- Enable CIC Protocol: No
- Bus Timing: 350 nsec
- Parallel Poll Duration: Default

**PSI8400 Device Settings**
- Primary GPIB Address: 5
- Secondary GPIB Address: None
- I/O Timeout Setting: 3 sec

ImPressOne should be able to be used with any PSI8400 system using the GPIB interface. Standard GPIB I/O functions are used to communicate through the NI GPIB-ENET/100 controller in the LSWT. However, general communication methods (e.g. read/write) have been programmed using object-oriented practices. Should the PSI8400 Ethernet upgrade be acquired, the core program will not require modification; only the internals of these communication methods will need to be changed.

### 3.2 PSI8400 Native Commands

ImPressOne uses native commands to communicate with and control the PSI8400. These commands are defined in the System 8400 Users Manual identified in Reference 2.

### 3.3 Printer Configuration

The print function within ImPressOne requires a printer to be setup for the PC. This printer may be any type; however, as the real-time chart is in colour, it is preferable for the default printer to be capable of printing in colour.

### 3.4 Installation Directory Structure

The ImPressOne default installation folder is “C:\Program Files\DSTO\ImPressOne”. The ImPressOne working folder has the directory structure shown in Figure 3. The “Log Files” folder contains a text file with logs of various events every time ImPressOne is run. The other subfolder contains the “Test Programs” that have been defined. These test programs allow the user to group test runs in order for clarity. Within each of these test program folders are the folders “Calibration Files”, “Data Files” and “Testplan Files” containing all the respective files that have been created.
within this test program. An additional log file containing information about events and communications relating to the PSI8400 system is written to a "Log Files" folder in the installation folder specified above.

![Figure 3: ImPressOne installation directory structure](image)

### 3.5 Publishing Pressure Data to the Network

Any pressure data that is read from the PSI8400 by ImPressOne, either from the real-time scan or from data acquisition, is written to National Instruments “DataSocket” structures on a data socket server. These data sockets are accessible to any other client on the local network. This allows an external application running on any other PC attached to the local network to have access to the data.

The socket containing the pressure port scan list is an array of type ‘double’. This is accessible from the URL "dstp://<host PC>/scatterX”. The socket containing the pressure port pressure values is also an array of type ‘double’. This is accessible from the URL "dstp://<host PC>/scatterY”.

When these socket structures are created, they will appear in the diagnostic window of the data socket server, as shown in Figure 4.
This publishing of pressure data to the network was incorporated into ImPressOne with the intention that the LSWT main data acquisition software will be able to integrate pressure acquisition in a future development. For more information on data sockets, refer to Reference 4.

4. ImPressOne Interface

4.1 Toolbar

The ImPressOne toolbar is shown in Figure 5. It contains the primary functionality required for the operation of the PSI8400. Some buttons may not be operable depending on the current state of the application.

Figure 5: ImPressOne toolbar
These buttons have the following functions:

4.1.1 Create/Open Testplan

Loads the Open Testplan form allowing the user to open a previously created testplan or create a new testplan. See Chapter 5 for more information.

4.1.2 Edit Testplan

Displays the details of the current testplan, allowing the user to change the description and configuration of the test. See Chapter 5 for more information.

4.1.3 Save Test Data

Prompts the user to select a file to save the data that has been acquired during the test. See Chapter 9 for more information.

4.1.4 Print Pressure Chart

Displays a print preview screen of the current pressure chart allowing the user to print a hard copy.

4.1.5 Connect to the PSI8400

Creates a connection with the PSI8400 by performing a serial poll on the device.

4.1.6 Initialise the PSI8400

Initialises the PSI8400 according to the configuration defined in the testplan. See Chapter 6 for more information.

4.1.7 Calibrate the PSI8400

This dropdown button allows the user to initiate either a full or a zero-offset calibration. See Chapter 7 for more information.

4.1.8 Reset the PSI8400 System

Sends a command to reset the PSI8400 voiding any initialisation or calibration that has been performed.

4.1.9 Start Real-Time Scan

Starts real-time scanning of the PSI8400. The pressure chart displays the resulting pressures that are being read from the configured scanners. See Chapter 8 for more information.
4.1.10  
Stop Real-Time Scan

Stops real-time scanning of the PSI8400.

4.1.11  
Export Graph Image

Export the balance trace chart image to file. The image can be saved to a number of different picture formats including bitmap, JPEG, PNG and TIFF.

4.1.12  
Zoom In

Vertically zoom in the pressure chart. The horizontal axes extents are not changed.

4.1.13  
Zoom Out

Vertically zoom out the pressure chart. The horizontal axes extents are not changed.

4.1.14  
Acquire Pressure Data

Initiates the acquisition of a pressure data set from the PSI8400. See Chapter 9 for more information.

4.1.15  
Enter Manual Command

Prompts the user to enter a command to the PSI8400. The command is sent and the response interpreted and displayed back to the user.

4.1.16  
Run Macro Script

Prompts the user to select a file containing a number of commands to send to the PSI8400. The commands are sequentially sent to the PSI8400 with the responses returned to the user.

4.1.17  
Serial Poll the PSI8400

Attempts to read a response from the PSI8400. If there is no response waiting to be read (i.e. the SRQ line is not asserted), a warning prompt will be displayed informing the user of the situation.

4.1.18  
ImPressOne Help

Displays the online help system for ImPressOne.

4.1.19  
About ImPressOne

Displays a splash screen showing the application information.
4.2 Main Menu

The main menu contains all the functionality provided from the toolbar as well as some more-detailed and less-used functions. It consists of six top level menus - File, Edit, View, Tools, Chart and Help. Parts of the menu hierarchy may be inaccessible depending upon the current state of ImPressOne.

4.2.1 File Menu

The file menu is shown in Figure 6. It contains all the commands relating to file operations. It has the submenus New, Open, Save and Print.

![Figure 6: ImPressOne file menu](image)

The following functions are accessible through this menu:

a) **New → Test Data File** — Clears the acquired data in memory allowing the user to start a fresh data file within a test. If data has been acquired and not been saved, it will first prompt the user as to whether they would like to save this data before starting a fresh file.

b) **Open → Testplan…** — Loads the Open Testplan form allowing the user to open a previously created testplan or create a new testplan. See Chapter 5 for more information.

c) **Open → Calibration File…** — Prompts the user to select a calibration file containing conversion coefficients from a previously saved calibration.

d) **Save → Testplan…** — Displays a save file dialogue to allow the user to select a file to save the current testplan.

e) **Save → Calibration Data…** — Prompts the user to select a file to save the latest calibration data. If the system is a full FIU system, it also allows the user to upload the adjustable zero/span coefficients to the scanner EEPROMs.

f) **Save → Test Data File…** — Displays a save file dialogue to allow the user to select a file to save acquired data.

g) **Print** — Prints a hardcopy of the current pressure chart to the default printer.

h) **Exit** — Quits the application, prompting the user to save any unsaved data.
4.2.2 Edit Menu

The edit menu is shown in Figure 7.

Figure 7: ImPressOne edit menu

The following functions are accessible through this menu:

a) Testplan… — Displays the details of the current testplan, allowing the user to change the description and configuration of the test. See Chapter 5 for more information.

b) System Processor Date/Time… — Loads the form shown in Figure 8. This allows the user to edit the PSI8400 SP date and time. Clicking the “Synchronise with PC time” button will set the date and time to be the same as the PC that ImPressOne is running on.

Figure 8: Edit system processor date/time form

4.2.3 View Menu

The view menu is shown in Figure 9. It contains commands relating to viewing various details from the PSI8400. It also allows the user to select whether or not the status bar and toolbar are visible.
The following functions are accessible through this menu:

a) **System Processor Date/Time** — Requests the date and time from the PSI8400 SP and displays the result to the user.

b) **Unit Firmware Version...** — Prompts the user to enter the cluster/rack/slot location of the unit to be interrogated, then requests the firmware version of the unit at the entered location and displays the result to the user.

c) **Pressure Port Group Details** — Displays the pressure port groups defined in the test plan to the user. It can be useful when determining a blocked port on the pressure chart.

d) **Initialisation Macro** — Displays the list of commands sent to the PSI8400 to initialise it according to the configuration defined in the test plan.

e) **Single Port Voltage...** — Prompts the user to enter the scanner pressure port number of the port to be interrogated, then requests the voltage of the port and displays the result to the user.

f) **Single Port Pressure...** — Prompts the user to enter the scanner pressure port number of the port to be interrogated, then requests the pressure of the port and displays the result to the user. The PSI8400 must have the proper conversion coefficients available for the requested port to use this function. These conversion coefficients may have come either from a calibration, loaded coefficients from a previous calibration or uploaded coefficients from a dtc-scanner.

g) **Single Port Temperature...** — Prompts the user to enter the scanner pressure port number of the port to be interrogated, then requests the temperature of the port and displays the result to the user. To use this function, the configuration must be
a full FIU system and the PSI8400 must have the proper conversion coefficients available for the requested port.

h) **Setup Table Conversion Coefficients** — Displays the conversion coefficients stored on the PSI8400 SP for the setup table defined in the testplan. These may be the o-coefficients for a conventional configuration or the dtc-coefficients for a full FIU configuration (refer to Appendix B). The PSI8400 must have conversion coefficients available to use this function.

i) **PCU Internal Coefficients...** — Prompts the user to enter the cluster/rack/slot location of the PCU to be interrogated, then requests the internal coefficients of the unit at the entered location and displays the result to the user.

j) **Status Bar** — Toggles the visibility of the status bar.

k) **Toolbar** — Toggles the visibility of the toolbar.

4.2.4 Tools Menu

The tools menu is shown in Figure 10. It contains the commands relating to initiating a process on the PSI8400. It also contains the function to allow the user to change various options in ImPressOne.

![Figure 10: ImPressOne tools menu](image)

The following functions are accessible through this menu:

a) **Connect to PSI8400** — Creates a connection with the PSI8400 by performing a serial poll on the device.

b) **Initialise PSI8400** — Initialises the PSI8400 according to the configuration defined in the testplan. See Chapter 6 for more information.

c) **Calibrate Scanners → Full Calibration** — Runs a full calibration on the PSI8400. See Section 7.1 for more information.

d) **Calibrate Scanners → Zero-Offset Calibration** — Runs a zero-offset calibration on the PSI8400. See Section 7.2 for more information.
e) **Calibrate Scanners → Write Dtc Coefficients** — Writes the adjustable dtc-coefficients from a previously performed calibration to the dtc-scanner EEPROM(s).

f) **Calibrate Scanners → Configure Calibration**… — Displays a form to allow the user to change the settings to use during a calibration. See Section 7.2 for more information.

g) **Reset PSI8400** — Sends a command to reset the PSI8400. Once the PSI8400 is reset, any previous initialisation and calibration information would be cleared from the PSI8400 system memory.

h) **Acquire Pressure Data** — Initiates the acquisition of a pressure data set from the PSI8400. See Chapter 9 for more information.

i) **Enter Manual Command**… — Prompts the user to enter a PSI8400 native command to the PSI8400. The command is sent and the response interpreted and displayed back to the user.

j) **Run Macro Script**… — Prompts the user to select a file containing a number of commands to send to the PSI8400. The commands are sequentially sent to the PSI8400 with the responses returned to the user.

k) **Options**… — Loads the Options form allowing the user to modify the General, Chart, Connection and Status user options. See Chapter 10 for more information.

### 4.2.5 Chart Menu

The chart menu is shown in Figure 11. It contains all the commands relating to the real-time scan. See Chapter 8 for more information on real-time pressure monitoring. The functionality in this menu requires the PSI8400 to be initialised.

![ImpressOne chart menu](image)

*Figure 11: ImpressOne chart menu*
The following functions are accessible through this menu:

a) **Start Realtime Scan** — Starts the real-time scan.
b) **Stop Realtime Scan** — Stops the real-time scan.
c) **Edit Visible Port Groups** — Loads a form to allow the user to change which pressure groups to display on the real-time chart.
d) **Plot Pressure Coefficients/Values** — Toggles whether to plot the pressure coefficients or the pressure values.
e) **Export Graph Image…** — Exports the pressure chart image to file. The image can be saved to a number of different picture formats including bitmap, JPEG, PNG and TIFF.
f) **Auto Scale** — Toggles whether the y-axis limits of the chart are dynamically modified to fit the current pressure data values.
g) **Show Cursor** — Toggles the visibility of the x-y point cursor.
h) **Show Legend** — Toggles the visibility of the chart legend.
i) **Show Windspeed** — Toggles the visibility of the windspeed indicator.

4.2.6 Help Menu

The Help menu is shown in Figure 12.

![Image](image.png)

*Figure 12: ImPressOne help menu*

The following functions are accessible through this menu:
a) **Contents** — Displays the contents page of the online help system.
b) **Index** — Displays the index page of the online help system.
c) **Search** — Displays the search page of the online help system.
d) **About…** — Displays a splash screen showing the application information.

4.3 Status Bar

The ImPressOne status bar gives feedback to the user as to the current states of the application and the PSI8400 system. The status bar is shown in Figure 13. It consists of the following panels:

- The application status displays any process or function currently running within ImPressOne.
The testplan status shows whether a testplan has been loaded or not within ImPressOne.

The connection status indicates whether ImPressOne has established a connection with the PSI8400.

The initialisation status indicates whether the PSI8400 system has been initialised according to the configuration in the current testplan.

The calibration status displays the highest level calibration performed on the PSI8400 since initialisation.

The PC Date/Time displays the current date and time of the host PC.

5. **ImPressOne Testplan**

The ImPressOne testplan contains the test title and test description as well as the configuration details of the PSI8400 and attached scanners.

To configure a testplan select “Create/Open Testplan” from the toolbar or “File → Open → Testplan...” from the main menu. This loads the Open Testplan form shown in Figure 14.
It is through this interface that the user is able to create and remove test programs defined in ImPressOne. It is also through this interface that the user can create new testplans, edit existing testplans and remove unwanted testplans.

To open a pre-existing testplan, select the appropriate test program from the Test Program list box on the left. This will populate the Testplan list box on the right with all the testplans that have been defined in the selected test program. Select the desired testplan and click the “Open Testplan” button.

To create a new testplan, select the appropriate test program from the Test Program list box. Then click the “New…” button to the right of the Testplan list box. This will load the form to allow the user to enter in the test title and description, and then the form to define the PSI8400 configuration.

5.1 Test Title and Description

The form to enter the test title and test description is shown in Figure 15. This allows the user to enter in a title for the test and also up to five description lines describing the test.
Once the title and description for the test have been entered, continue by selecting the “Next >” button. This will load the form to define the PSI8400 configuration.

5.2 PSI8400 Configuration

The form to enter the configuration of the PSI8400 is shown in Figure 16. This allows the user to define the components attached to the PSI8400, the data acquisition parameters and the pressure ports to be scanned. The components that have been defined are shown in the form as well as a brief description summarising the important parameters for each component.
Components can be added by either double clicking the appropriate “Add <component>” text in the listbox or by clicking the “Add…” button. To edit predefined components, either double click the component in the list box to edit or select
the component then click the “Edit…” button. Previously defined components can be
deleted from the configuration by selecting the component in the list box and then
clicking the “Remove” button.

There are six types of components that constitute a PSI8400 configuration. These are
the PCU(s), SDU, Scanner(s), Setup Table, Pressure Port Group(s) and Dynamic Port.
These components are explained in the following sections. A more detailed description
of each of these components is given in Reference 2.

5.2.1 Pressure Calibrate Unit (PCU)

The PCU is a general-purpose, digitally-controlled, pneumatic calibration source
and/or pressure generator. Each PCU attached to the PSI8400 must be defined in the
configuration even if it is not used for the test. The form used to define a PCU is shown
in Figure 17.

![Figure 17: PSI8400 PCU configuration form](image)

The following parameters must be entered to successfully characterise a PCU:

- **Cluster/Rack/Slot**: A three-digit number defining the location of the PCU in the
  PSI8400 chassis.
- **Logical Range Number**: A unique number between 1 and 12 that is needed by
  pressure scanning units to refer to this PCU.
- **Maximum Pressure**: The maximum pressure that the PCU can generate.
- **Pressure Mode**: The type of pressure mode for the PCU, either differential or
  absolute.
Setting Tolerance: The setting tolerance, in psi units (as required by the PSI8400), to use for calibration pressures.

Calibration Pressures: A list of two to five pressures to generate when running a full calibration.

5.2.2 Scanner Digitiser Unit (SDU)

The SDU performs the analogue to digital conversion of the analogue signal from the pressure scanners. Only one SDU may be defined in a test configuration, even if several are attached to the PSI8400. The form used to define an SDU is shown in Figure 18.

![Figure 18: PSI8400 SDU configuration form](image-url)

The following parameters must be entered to successfully characterise a SDU:

- **Unit Type**: The type of SDU. This can be either a conventional SDU or a Fibre-Optic Interface Unit (FIU). The FIU is an advanced SDU in which the analogue to digital conversion occurs in a remote unit called the Scanner Digitizer Interface (SDI). It is the SDI that the scanners are attached to.
- **Cluster/Rack/Slot**: A three-digit number defining the location of the SDU in the PSI8400 chassis.

5.2.3 Pressure Scanner

Electronic pressure scanners are differential pressure measurement units consisting of an array of silicon piezoresistive pressure sensors, one for each pressure port. A dtc-scanner is shown in Figure 19.

![Figure 19: dtc-scanner](image-url)

Each scanner attached to the SDU must be defined in the test configuration. The form used to define a pressure scanner is shown in Figure 20.
The following parameters must be entered to successfully characterise a scanner:

- **Logical Range Number**: The logical range number of the PCU to use when calibrating this scanner.
- **Number of Ports**: The number of pressure ports on the scanner.
- **Maximum Pressure**: The maximum pressure that the scanner can sense.
- **Scanner Type**: The type of scanner. This can be either a conventional scanner (o-scanner) or digitally temperature compensated scanner (dtc-scanner). The dtc-scanner is an advanced scanner which also measures and corrects for temperature effects. These scanners have embedded EEPROM containing factory-determined coefficients. This results in much more accurate measurements and increased efficiency due to the reduced need to perform full calibrations.

- **Use Sensitive Range**: This causes dtc-scanners to use their ‘sensitive’ range which is 33% of their full-scale range. This results in higher accuracy when the pressures anticipated are less than 33% of the full-scale range of the scanner. It has no effect on o-scanners.

To take advantage of the benefits of dtc-scanners, they must be attached to a FIU. If using a conventional SDU, dtc-scanners can still be used; however, they will behave as conventional o-scanners. Using o-scanners with an FIU will also void the benefits of an FIU causing it to run in a conventional SDU emulation mode.

### 5.2.4 Data Acquisition (DA) Setup Table

The setup table defines the parameters to use for each data acquisition set. Only one setup table can be defined in a test configuration. The form used to define the setup table is shown in Figure 21.

![Configure Setup Table](image)

**Figure 21**: PS18400 setup table configuration form
The following parameters must be entered to successfully characterise the setup table:

- **Number of Frames**: The number of frames (or readings) that are combined into each measurement set. A frame consists of a sequential reading of each port defined under the pressure port groups. A measurement set consists of an average reading for each pressure port across the frames that have been obtained.
- **Frame Delay**: The time period in microseconds between the start of consecutively scanned frames.
- **Number of Measurement Sets**: The number of pressure measurement sets to acquire each DA run.
- **Measurement Set Delay**: The time period in milliseconds between measurement sets.
- **Trigger Mode**: The triggering mode options are:
  - **Free** – Free run (ignore trigger);
  - **ITrig** – Trigger initial measurement set of DA run; or
  - **ATrig** – Trigger each measurement set of DA run.

For an FIU in Full-FIU mode, the ITrig and ATrig options cause the ez-set (generated at the start of each DA run) to be scanned and transmitted early to the SP, before the trigger signal starts acquisition of all other temp-set/press-set pairs. This avoids the "time bump" normally caused by scanning the ez-set. However, this "time bump" will always be experienced in the Free run mode.

- **Scan Mode**: The method by which the SDU performs the actual scanning of individual scanner ports. This can be either:
  - **SEQ** – Sequential, the scanner ports are scanned in the exact order specified in the scan list; or
  - **PAM** – Parallel Address Mode, the ports of different scanners are scanned concurrently to achieve higher rate of data acquisition. This only has an effect when using a conventional SDU and the number of scanners are greater than four.

- **Output Format**: Defines the Output/Convert Format of each measurement set as it arrives at the host. It can have the following values:
  - **Raw** – Host receives each raw measurement set generated by the SDU. This option is not currently supported in ImPressOne.
  - **EU_Pressure** – Host receives only normal Engineering Unit (EU) pressure measurement sets. This is the default option and currently the only supported option in ImPressOne.
  - **PressureAndCompSet** – Host receives the EU pressure set; additionally, the ez-set and all temperature sets acquired from a full-FIU configuration will also be sent to the host. The ez-set is an excitation and zero measurement set containing an excitation voltage array for each defined scanner and a zero reference voltage array. The ez-set appears only at the beginning of each data acquisition run. Data from the ez-set is used to automatically compensate for analogue zero shifts and excitation voltage shifts. This option is not currently supported in ImPressOne.
5.2.5 Pressure Port Group

The pressure port group(s) defines the actual ports to scan in each pressure scanner for each data acquisition set.

Grouping pressure ports into meaningful collections results in numerous benefits:

- Clearer viewing of the real-time chart;
- Simplified data analysis;
- Easier recognition of a failed scanner during a run;
- Easier to determine a blocked port ID on the real-time chart.

The form used to define a pressure port group is shown in Figure 22.

![Figure 22: PSI8400 pressure port group configuration form](image)

The following parameters must be entered to successfully characterise a pressure port group:

- **Group Name**: The name to use to identify the pressure port group.
- **Defined Ports**: A list of the port(s) allocated to the pressure port group. This can be a single port or a range of ports or multiple combinations of these, separated using a comma. Use the “sspp” or “spp” format to define a port where “ss” or “s” refers to the scanner number and “pp” is the port number. The defined ports become the scan list to use for each data acquisition set and are the way in which data will be written in the test data file.

5.2.6 Dynamic Port

The dynamic port allows the user to define one of the ports contained in one of the pressure port groups to be used for the local dynamic pressure. This allows the user to plot pressure coefficients if they desire.

The form used to define the dynamic port is shown in Figure 23.
Figure 23: Dynamic pressure scanner port number form

If the port entered is invalid or not contained in one of the defined pressure port groups, a warning prompt will be displayed to the user.

5.3 Saving the ImPressOne Testplan

When a testplan is edited from either the “Open Testplan” form or from the main user interface, the user is prompted to save the edited testplan as shown in Figure 24. This allows the user to base a new testplan on an old one without having to redefine the PSI8400 configuration.

Figure 24: Save testplan prompt

If the user chooses to save the testplan, a save file dialogue is displayed as shown in Figure 25. Testplan files as saved by default in the “Testplan Files” folder in the current test program.
The testplans in ImPressOne are saved in the “.xml” file format. The user should not need to view these files directly. An example of an “.xml” testplan file is shown in Appendix A.

6. PSI8400 Initialisation

Before scanner calibration or data acquisition may begin, the PSI8400 must have all of its input units initialised. The parameters governing data acquisition must also be uploaded. This is achieved through sending a series of initialisation commands to the PSI8400 SP. For information on the specifics of these commands and their significance, refer to Chapters 4 and 5 of Reference 2.

ImPressOne automatically generates the PSI8400 initialisation commands from the configuration defined in the testplan. The user may view these commands if desired through the “View → Initialisation Macro” command in the main menu. An example is shown in Figure 26.
To send these commands to the PSI8400 select the “Initialise” button on the toolbar or “Tools → Initialise PSI8400” through the main menu. If the configuration is incomplete, a warning prompt will be displayed specifying the components that still need to be defined or that may have been incorrectly defined. An example is shown in Figure 27.

Assuming the configuration is sufficiently defined, the initialisation process will setup the real-time scan chart and commence uploading the commands to the PSI8400. The initialisation progress, shown in Figure 28, will be displayed as the PSI8400 commands are uploaded. The response from each command is shown as it is received. The user may cancel the initialisation at any time by clicking the “Cancel” button. This will terminate sending any more initialisation commands once the response from the current command has been received. PCU initialisation commands can take some time.
Once the initialisation is complete, the real-time scan can be commenced with the results displayed on the pressure chart.

7. PSI8400 Calibration

To convert the voltages measured on the pressure ports of the electronic pressure scanners, the PSI8400 SP must have a set of conversion coefficients available. These conversion coefficients may originate from a number of sources:

- If the system is a full-FIU configuration, the conversion coefficients stored on the dtc-scanner’s (or scanners’) embedded EEPROM are uploaded to the PSI8400 SP during the initialisation process.
- If the system is a conventional SDU configuration or is using o-scanners, the conversion coefficients must be obtained from performing a full calibration on the PSI8400 or uploaded from conversion coefficients that have been saved to file from a previously performed calibration.

Details on the conversion equations and associated conversion coefficients are given in Appendix B.
7.1 Full Calibration

Depending on the type of configuration defined in the testplan, running a full calibration can have two different effects.

When the system is not a full-FIU configuration, an o-scanner-type full-pneumatic calibration is performed on the PSI8400. This calculates new offset and slope o-coefficients ($c_0$ and $c_1$) and, depending upon the number of calibration points defined for the PCU assigned to the particular scanner, up to three additional new non-linearity o-coefficients ($c_2$ to $c_4$).

When the system is a full-FIU configuration using dtc-scanners, a faster dtc-scanner-type full-pneumatic calibration is performed. This only calculates new adjustable dtc-coefficients ($C_z$ and $C_s$). If more than two calibration points are defined for the PCU assigned to the scanner, only the highest and lowest calibration pressure points will be used during the calibration.

Full calibration can take a significant amount of time to perform. This can vary from 5 to 20 minutes depending on the number of calibration points. As the calibration is running, an indication of the progress is displayed as shown in Figure 29. The calibration may be cancelled at any time by clicking the “Cancel” button. It may take a while for the calibration progress to be terminated as the current calibration point must be completed first.

![Figure 29: PSI8400 full calibration progress form](image)

Once the calibration has been completed, the result will be shown in the calibration progress form and a prompt as to whether to save the calibration coefficients to file will be displayed, as shown in Figure 30.
A full calibration is recommended if the temperature environment has changed significantly since the last full calibration.

7.2 Zero-Offset Calibration

Running a zero-offset calibration performs a limited Zero-Only pneumatic pressure calibration for the scanner ports defined in the testplan. It calculates new offset o-coefficients (o₀) for conventional configurations or new offset dtc-coefficients (C₂) for full-FIU configurations.

Before this type of calibration can be performed in a conventional configuration, o-coefficients must already be available to the PSI8400, either by performing a full calibration or by loading them from a previously saved calibration.

The zero-offset calibration is significantly faster than a full calibration, taking around two minutes, so no progress is indicated other than the busy cursor and the “Calibrating Scanners...” indicator in the status bar application panel. Once the zero-offset calibration is complete, a message box will be displayed, as shown in Figure 31, indicating the result of the calibration.

The zero-offset calibration reduces any time-dependent error in the overall system. It is recommended that this type of calibration be performed prior to commencing every test.
7.3 Calibration Configuration Settings

There are two calibration configuration settings that can be changed by the user. These are the pulse duration to use for the valve control and the stabilisation time, which is the amount of time the PSI8400 SP will wait for each calibration pressure to stabilise before reading any data. The default value for both of these parameters is five seconds.

To change either of these values, select “Configure Calibration…” on the dropdown menu from the “Calibrate” button on the toolbar or “Tools → Calibrate Scanners → Configure Calibration…” through the main menu. This will bring up the form shown in Figure 32.

![Configure Calibration Parameters](image)

Figure 32: ImPressOne calibration configuration form

After changing the parameters to the desired values, clicking the “OK” button will send the appropriate command to the PSI8400. The response from this command will then be displayed to the user.

7.4 Save Calibration Data

After a full calibration or a zero-offset calibration, the calibration data may be saved to file. This file can then be used to restore the calibration coefficients for a conventional configuration without the need to perform another full calibration. It can also be used for post analysis of the calibration results.

The calibration file saved is text based and has the “.cal” extension. It is saved in the “Calibration Files” folder of the current test program by default. An example of a saved calibration file is shown in Appendix C. The file contains the basic details of the current test, the calibration date and time, the pressures that were set by the PCU(s) during the calibration, the pressure port scan list, the calibration voltages read on each port at each calibration point during the calibration and the calibration coefficients that were calculated as a result of the calibration.
If the PSI8400 configuration is a full FIU-system, ImPressOne will also give the option of writing the newly calculated adjustable zero/span dtc-coefficients ($C_\text{Z}$ and $C_\text{S}$) to the embedded EEPROM of the scanner(s).

### 7.5 Open Calibration File

Opening a previously saved calibration file allows the user to use the calibration coefficients from a previously performed calibration in the current test. In a conventional configuration, this minimises the requirement to perform time-costly full calibrations. The configuration that was used in the calibration file being loaded should be the same as that in the current test, otherwise unpredictable results may occur.

Depending on the time span between when the calibration coefficients being loaded were obtained and the current date, ImPressOne may prompt a recommendation to perform either a new full calibration or a zero-offset calibration. A zero-offset calibration is recommended if the time span is over two days and a full calibration is recommended if the time span is over 30 days. These are general recommendations and the user should calibrate the scanners according to the accuracy requirements of the test.

### 8. ImPressOne Real-Time Pressure Monitoring

The real-time pressure monitoring is one of the two main functions of ImPressOne. The other is data acquisition, which is presented in Chapter 9. Monitoring has been designed to be as simplistic and as versatile as possible. The real-time scan launches automatically as soon as the PSI8400 has been initialised. The pressure chart will then show the pressure values of all the pressure ports in the configured pressure port groups.

All the functionality of the pressure chart is contained in the chart menu as described in Section 4.2.5. This menu is also available by right clicking anywhere in the chart or legend area. These functions will now be described in detail.

#### 8.1 Start/Stop Real-Time Scan

The user may stop the real-time scan at any time. This may be to have a look at the instantaneous pressures or before starting another function.

#### 8.2 Edit Visible Port Groups

In a complex pressure test, the number of pressure ports being scanned may be in the order of hundreds. Viewing all these ports on the pressure chart at once reduces clarity. Hence, the ability to group pressure ports has been integrated into ImPressOne.
This allows the user to choose which groups to show on the pressure chart at any one time. Selecting this option will bring up a form, shown in Figure 33, allowing the user to select which pressure port groups to display on the current pressure chart. When multiple scanners are used, it is recommended to group a single port from each scanner. This grouping can be kept always visible so that it’s instantly apparent if one of the scanners has failed.

![Visible pressure port group selection form](image)

*Figure 33: Visible pressure port group selection form*

Changing the visibility of the port groups can also be accomplished by right clicking the legend which will bring up a context menu allowing the user to select which groups to display.

To simplify the ability to identify individual pressure ports on the pressure chart, the first port number of each pressure port group is displayed on the x-axis. Through the “View → Pressure Port Group Details” menu the user can bring up the port group details showing the full list of port numbers defined in each group. An example of this is shown in Figure 34. Using this in combination with the pressure chart legend, the user can easily identify individual ports on the chart. For example, the eighth port from the end of the “aqua” group appears as though it may be blocked. Using the legend, it is seen that this group is “Group A”. From the view port group details display, the ports assigned to this group are “103, 105-116, 118, 120-125”. Thus the eighth port from the end would be port 116. The user can then check the tubing for this port to determine any faults.
8.3 Plot Pressure Coefficients/Values

By default, the pressure values, usually in psi, are plotted on the pressure chart. If a dynamic port has been defined in the test plan, the pressure coefficients can be displayed on the pressure chart. The pressure coefficient is defined by the equation:

\[ C_p = \frac{P}{q} \]

where \( q \) is the dynamic pressure

8.4 Show Cursor

If the user wants to concentrate on a particular point of interest, this function brings up a cursor which can be dragged onto the pressure port that they want to monitor. This cursor displays the current coordinates of the point it is attached to. The first coordinate is the horizontal position of the point on the chart and the second coordinate is the pressure value of the port. An example of this is shown in Figure 35.
Figure 35: Cursor use on the pressure chart

An additional way of viewing the value of a particular point is by holding the mouse cursor over the point of interest for a couple of seconds at which point a tooltip will appear displaying the value of interest.

8.5 Show Legend

The legend, which identifies by colour the port group associated with which plot, can be hidden if desired. This may be useful when only a couple of pressure port groups are displayed on the pressure chart.

8.6 Show Windspeed

The windspeed indicator displays the windspeed as determined by the equation:

\[ V = \sqrt{\frac{2q}{\rho}} \]

where : \( q \) is the dynamic pressure
\[ V \] is the windspeed
and : \( \rho \) is the air density
For the windspeed indicator to be available, the dynamic pressure port must be configured in the testplan as this is used for the dynamic pressure. The air density used is $2.378 \times 10^{-3}$ slug/ft$^3$. This indicator can be hidden if desired.

8.7 Interacting with the Pressure Chart

The pressure chart supports the following user interactions:
- Editing the vertical axis range;
- Zooming in the horizontal and vertical directions;
- Panning in the horizontal and vertical directions, and;
- Cursor movement.

Additionally, the y-axis limits and behaviour can be modified through the chart options. See to Section 10.3 for more information.

8.7.1 Edit Vertical Axis Range

To edit the vertical axis range, click on either the upper or lower y-axis value. Enter the desired new value. If auto scale has been selected, the range entered will be changed automatically once new data is acquired.

8.7.2 Zooming

To zoom horizontally or vertically, press and hold the <Shift> key and click and drag the mouse to create a selection in the plot area of the chart. Release the mouse button to zoom in around the selection. You can also use the mouse wheel or the up and down arrow buttons on the keyboard for zooming. Press and hold <Shift>, then scroll the mouse wheel to the desired zoom or alternatively press the up arrow button to zoom in or the down arrow button to zoom out.

8.7.3 Panning

To pan horizontally or vertically, press and hold <Ctrl> and click and drag the mouse in the plot area. Alternatively, press and hold <Ctrl>, then press the left or right arrow button to pan horizontally or press the up or down arrow buttons to pan vertically.

8.7.4 Cursor Movement

If a cursor is visible on the pressure chart, the user may move the cursor onto the desired pressure port they want to monitor. To move the cursor, click either the horizontal crosshair or the vertical crosshair of the cursor and drag the cursor in the plot area of the chart. To move the cursor across pressure groups, click the centre section of the cursor and drag the cursor to the desired point.
9. ImPressOne Data Acquisition

Pressure acquisition is the other main function of ImPressOne. ImPressOne is only designed to acquire the pressure data, not to perform any analysis. The pressure data can be saved to file for post analysis. The format used is designed for easy access by Microsoft Excel©, or a similar package, to read and analyse the data.

Once the PSI8400 has been initialised and calibrated satisfactorily, the user can take pressure data sets at any time by clicking the “Acquire Data” toolbar button or by selecting “Tools → Acquire Pressure Data” from the main menu. This will immediately stop the real-time scan (if running) and commence the acquisition of a data set according to the setup table definition in the test plan. The progress in acquiring the data set is shown by a progress bar, as indicated in Figure 36.

![Figure 36: Acquiring data progress bar](image)

At the completion of the data set, the user will be prompted to enter a label for the data set, as shown in Figure 37. If the user cancels at this point using the “Cancel” button, the data set will be discarded. Otherwise, the data set will be added and saved to a temporary file (“temp.dat”) in the “Data Files” folder of the current test program directory. This can be useful in the case of the application crashing as the data will still be saved. The real-time scan will recommence, if previously running, after the data set acquisition process is complete.

![Figure 37: Data set label prompt](image)

The user may take as many data sets as required during a test.
9.1 Save Test Data File

The user can save the test data to file using either the “Save” button on the toolbar or through “File → Save → Test Data File…” in the main menu. This will bring up a save file dialogue prompt requesting the user to enter in the name of the file where the test data will be saved. The test data file contains the units of the pressure data, pressure port group names, pressure port group scan lists, test data sets, test information and test configuration. For an example of a test data file, see Appendix D.

9.2 New Test Data File

If the user wants to start a fresh data file after already having taken some data sets, they can select “File → New → Test Data File” from the main menu. The program will prompt the user to save any unsaved data and then a new temporary file will be created to store newly acquired test data from then on.

10. ImPressOne Options

ImPressOne contains a number of user-configurable options. These can be modified through “Tools → Options…” in the main menu. They are discussed in the following sections.

10.1 General Options

The general options are shown in Figure 38. These contain options relating to general settings of the application.
“Show Status Bar” and “Show Toolbar” have the same functionality as that previously described in Section 4.2.3 allowing the user to modify the visibility of the ImPressOne status bar and toolbar. “Publish Data” allows the user to toggle whether any data that is read from the PSI8400 (whether it be from a real-time scan or a data acquisition) is published to the network data socket server specified by “Server Url”.

10.2 Connection Options

The connection options are shown in Figure 39. These contain options relating to the GPIB connection to the PSI8400. If the GPIB configuration is different to the default setting for PSI8400 systems, these settings allow the user to still make a connection with the system, but without requiring modifications to the program. These settings are persistent. They are saved and restored when the application is closed and restarted.
The “Board Number” is the GPIB board number that the PSI8400 system is connected to. The “Primary Address” is the primary GPIB address of the PSI8400 device. The “Secondary Address” is the secondary GPIB address of the PSI8400 device. The “Timeout Value” is the GPIB I/O timeout value. The default settings are “0”, “5”, “0”, and “T3s” respectively, where T3s represents a value of three seconds.

10.3 Chart Options

The chart options are shown in Figure 40. These contain options relating to the appearance of the pressure chart in ImPressOne.
“Show Legend” and “Show Cursor” have the same functionality as that previously described in Section 4.2.5, allowing the user to modify the visibility of the chart legend and the xy-cursors. The “Auto Scale” option causes the y-axis limits to change dynamically depending on the current pressure data so that all data is displayed within the extent of the chart. The “Manual” option allows the user to fix the extents of the y-axis to the values in the “Minimum” and “Maximum” text entries.

10.4 Status Options

The status options are shown in Figure 41. These contain options relating to the current status of ImPressOne. They can be used if the application indicates on the status bar (Section 4.3) that it is in a state that the user knows is incorrect. They must be used carefully as incorrect setting of these states may cause the application to function incorrectly.
“Run Number” allows the user to modify the run number to use for the test. “Is Connected” sets the connection status of ImPressOne. “Is Initialised” sets the initialisation status of ImPressOne. This can be used, for example, if the PSI8400 was initialised when the application was last closed. When the application was restarted with the restore status option not chosen and it was then decided to restore the status, then this could be done without the need to reinitialise the PSI8400. “Is Calibrated” sets the calibration status of ImPressOne. This can be useful if the application is closed after a calibration has been performed and then restarted without restoring the last status. If the user then decides to use the calibration data stored in the PSI8400 system memory, this can be done through this function. When restoring the “Is Initialised” and “Is Calibrated” state using this method, the testplan must be opened first.

11. Conclusions and Future Development

A software package called ImPressOne has been developed under a new programming environment as part of the Low Speed Wind Tunnel (LSWT) Data Acquisition System (DAS). This was required due to inadequacies in the old software and so that features of the upgraded PSI8400 components could be utilised.

The software displays and monitors, in near real time, the pressure values in a test. It also has the ability to acquire pressure data according to a predefined setup table and save this data to file. This document details the operation and functionality of the
ImPressOne software with some emphasis on application by tunnel engineers and operators.

Future development of ImPressOne could include the ability to:

- acquire raw data and temperature data;
- expand the range of user options available; and
- improve the pressure port number display on the pressure chart.

The software has been developed in Microsoft Visual C#.NET and a competent programmer, having become familiar with the program, should be capable of making modifications and upgrades, if required.

12. References


Appendix A: An Example of an ImPressOne Testplan File

```xml
<?xml version="1.0" standalone="yes" ?>
<TestPlanSchema xmlns="http://tempuri.org/TestPlanSchema.xsd">
  <TestDescription>
    <testTitle>FA18 FS Reynolds 01</testTitle>
    <description0>F/A 18 Reynolds Number Effect Test</description0>
    <description1>V = 20, 30, 40, 50, 60, 70 m/s;</description1>
    <description2>Pitch = -15 to +15 deg;</description2>
    <description3>Tare coefs generated 19/05/05</description3>
    <timeSaved>2005-06-23T16:42:16.1498069+10:00</timeSaved>
  </TestDescription>
  <PCU>
    <id>0</id>
    <crs>211</crs>
    <lrn>1</lrn>
    <pressureMode>1</pressureMode>
    <pressureUnits>1</pressureUnits>
    <maxPressure>1</maxPressure>
    <settingTolerance>0.01</settingTolerance>
    <calPressure>-0.9, -0.5, 0, 0.5, 0.9</calPressure>
  </PCU>
  <SDU>
    <id>0</id>
    <crs>112</crs>
    <type>1</type>
    <nScanners>1</nScanners>
  </SDU>
  <Scanner>
    <id>0</id>
    <lrn>1</lrn>
    <nPorts>32</nPorts>
    <maxPressure>1</maxPressure>
    <type>1</type>
    <useSensitive>false</useSensitive>
  </Scanner>
  <PortGroup>
    <id>0</id>
    <name>static</name>
    <nPorts>1</nPorts>
    <definedPorts>101</definedPorts>
  </PortGroup>
</TestPlanSchema>
```
- <PortGroup>
  <id>1</id>
  <name>dynamic</name>
  <nPorts>1</nPorts>
  <definedPorts>102</definedPorts>
</PortGroup>
- <PortGroup>
  <id>2</id>
  <name>Station A</name>
  <nPorts>22</nPorts>
  <definedPorts>105-112, 115, 120-132</definedPorts>
</PortGroup>
+ <SetupTable>
  <id>1</id>
  <crs>112</crs>
  <nTable>2</nTable>
  <nFrames>40</nFrames>
  <frameDelay>25000</frameDelay>
  <nMeasurementSets>1</nMeasurementSets>
  <setDelay>2000</setDelay>
  <trigMode>0</trigMode>
  <scanMode>0</scanMode>
  <outputFormat>2</outputFormat>
</SetupTable>
- <MiscProperties>
  <sportDynamic>205</sportDynamic>
  <indexDynamic>41</indexDynamic>
</MiscProperties>
</TestPlanSchema>
Appendix B: PSI8400 EU Pressure Conversion Equations

The pressure port conversion coefficients can be one of two types, B1 or B2, depending on the type of configuration.

B.1. Conventional System

When the system is not a full-FIU configuration, up to five conversion coefficients are used to determine the port pressure ($c_0, c_1, c_2, c_3$ and $c_4$), hereafter referred to as o-coefficients. These o-coefficients are used to calculate the port pressure ($P$) according to the following equation:

$$P = c_0 + c_1 V + c_2 V^2 + c_3 V^3 + c_4 V^4$$

where $V$ is the measured port voltage

Each pressure port defined in the scan list requires its own unique set of o-coefficients.

B.2. Full-FIU System

When the system is a full-FIU configuration using dtc-scanners, 23 conversion coefficients are used to determine the port pressure, hereafter referred to as dtc-coefficients. These coefficients are categorised into the following nine groups:

- Group 0 – Adjustable group; $C_2, C_5$
- Group 1 – Pressure group A; $A_0, A_1, A_2, A_3$
- Group 2 – Pressure group B; $B_0, B_1, B_2, B_3$
- Group 3 – Pressure group C; $C_0, C_1$
- Group 4 – Pressure group D; $D_0, D_1$
- Group 5 – Temperature group Q; $Q_0, Q_1$
- Group 6 – Temperature group R; $R_0, R_1$
- Group 7 – Temperature group S; $S_0, S_1$
- Group 8 – Temperature group T; $T_0, T_1, T_2$

Each pressure port on the dtc-scanner has its own unique set of dtc-coefficients. These coefficients are used to determine the port temperature and pressure according to the methodology described as follows.
A normalised temperature reading is determined by the equation:

\[ t_n = \frac{t_r - z_r}{e_r - z_r} \]

where \( t_r \) is the scanned pressure port's raw temperature reading;
\( e_r \) is the scanner's raw excitation voltage, and;
\( z_r \) is the SDI's A/D's raw zero reference

\[ (4) \]

A normalised pressure reading is determined by the equation:

\[ p_n = \frac{p_r - z_r}{e_r - z_r} \]

where \( p_r \) is the scanned pressure port's raw pressure reading

\[ (5) \]

These normalised values account for any simple A/D zero-offset shifts and excitation voltage changes.

Now, a set of internal coefficients (q, r and s) are determined using the temperature groups 5-7 of the dtc-coefficients:

\[ q = Q_0 + Q_1 t_n \]
\[ r = R_0 + R_1 t_n \]
\[ s = S_0 + S_1 t_n \]

\[ (6) \]

These are used to determine the pressure corrected normalised raw temperature (tc):

\[ t_c = q + rp_n + sp_n^2 \]

\[ (7) \]

This corrected raw temperature, together with pressure groups 1-4 of the dtc-coefficients, allows the calculation of the dynamic final pressure equation coefficients or fpe-coefficients (a, b, c, and d):

\[ a = A_0 + A_1 t_c + A_2 t_c^2 + A_3 t_c^3 \]
\[ b = B_0 + B_1 t_c + B_2 t_c^2 + B_3 t_c^3 \]
\[ c = C_0 + C_1 t_c \]
\[ d = D_0 + D_1 t_c \]

\[ (8) \]
These fpe-coefficients are used with the normalised pressure reading and the group 0 (or the zero and span "adjustable") dtc-coefficients to determine the actual port pressure ($P$):

$$P = C_z + C_s (a + bp_n + cp_n^2 + dp_n^3)$$  \hspace{1cm} (9)

The corrected raw temperature is also used with the temperature group 8 dtc-coefficients to determine the port temperature ($T$):

$$T = T_0 + T_1 t_c + T_2 t_c^2$$  \hspace{1cm} (10)
Appendix C: An Example of an ImPressOne Calibration File

"ImPressOne Calibration Data File"

TEST PROGRAM TITLE
O-Scanner Test

TEST PROGRAM DESCRIPTION

INITIALISATION FILE
oscanner_lrn1.ini

CALIBRATION DATE
9/3/2005

CALIBRATION TIME
5:21:53 PM

CALIBRATION PRESSURES
P1; P2; P3;
-0.899575797255707; 2.17017804970965E-05; -0.0221717394888401;

SCAN LIST
101;
105;
106;
107;
108;
109;
110;
111;
112;
113;
114;

CALIBRATION VOLTAGES
V1; V2; V3;
-0.397186279296875; -0.025634765625; -0.0347900390625;
-0.394744873046875; -0.022430419921875; -0.031585693359375;
-0.403289794921875; -0.028228759765625; -0.037384033203125;
-0.405731201171875; -0.03204345703125; -0.041046142578125;
-0.4194611328125; -0.046844482421875; -0.055999755859375;
-0.4205322265625; -0.046539306640625; -0.0555419921875;
-0.390625; -0.019989013671875; -0.02899169921875;
-0.36529541015625; -0.02532958984375; -0.033721923828125;
-0.404815673828125; -0.029144287109375; -0.03814697265625;
-0.402679443359375; -0.028533935546875; -0.037841796875;
-0.41107177734375; -0.02685546875; -0.03631591796875;
CALIBRATION COEFFICIENTS

\[ c_0; c_1; c_2; \]

\[
0.0621575713157654; 2.42405796051025; 0.00435708416625857;
0.0544035136699677; 2.42491674423218; 0.0183687843382359;
0.0684937089681625; 2.42757368087769; 0.0649540051817894;
0.079200368237495; 2.47598767280579; 0.154465764760971;
0.11372927207947; 2.42849707603455; 0.0283150784671307;
0.115135297179222; 2.48095083236694; 0.15961056907272;
0.0493676960468292; 2.47063684463501; 0.103331975638866;
0.0670093446969986; 2.64439725875854; -0.00734968343749642;
0.07206528403819427; 2.47751593589783; 0.188645256766777;
0.067985862493515; 2.38024568557739; -0.0583875551819801;
0.0630471184849739; 2.34704351425171; 0.0106441518291831;
\]
Appendix D: An Example of an ImPressOne Test Data File

"ImPressOne Test Data File"

DATA UNITS
psi

DEFINED PRESSURE PORT GROUPS
static
dynamic
Station A

PORT GROUP SCAN LISTS
101;
102;
105; 106; 107; 108; 109; 110; 111; 112; 124; 129; 130; 131; 132;

TEST DATA

Data Set:
1
Description:
V = 10 m/s, pitch = 5 deg
Measurement Set:
1
Time:
2:34:46 PM
0.00925248954445124;
0.0142638543620706;
0.00845375371684832; 0.0151277687400579; 0.00680864043533802;
0.0123543087393045; 0.00879974570125341; 0.00583014078438282;
0.00826780591160059; 0.00429803133010864; 0.013961804099381;
0.0103906355798244; 0.0125143844634295; 0.0085063623264432;
0.00725381635129452;
Measurement Set:
2
Time:
2:34:48 PM
0.00965473894029856;
0.0140046896412969;
0.00869366363149054; 0.015235710889101; 0.0065737878490928;
0.012119237182736; 0.00872701033949852; 0.0060383589069604;
0.0080141676598466; 0.00384141341783106; 0.0137429013848305;
0.0104849562048912; 0.0125877531245351; 0.008754494599990;
0.00775408410849111;
Data Set:
2
Description:
V = 10 m/s, pitch = 10 deg

Measurement Set:
1
Time:
2:35:03 PM
0.00991917122155428;
0.0144621236249804;
0.00909618940204382; 0.0155623033642769; 0.00686533842235804;
0.012470543384552; 0.00862823985517025; 0.00686291651800275;
0.0085638677701354; 0.00460168067365885; 0.0140104871243230;
0.0106167886406183; 0.0127597590908408; 0.00916070677340031;
0.00754791405051947;

Measurement Set:
2
Time:
2:35:05 PM
0.00985628552734852;
0.0139940055087209;
0.00901798531413078; 0.015608542598784; 0.0066641373598326;
0.012661355476069; 0.0091968578442431; 0.00663044676184654;
0.00857262220233679; 0.00498295295983553; 0.0144095160067081;
0.0103434827178717; 0.0127611430361867; 0.00909965950995684;
0.00781281851232052;

"ImPressOne Test Information Data"

RUN NUMBER
50

DATE
28/6/2005

START TIME
2:36:30 PM

TEST TITLE
FA18 FS Reynolds 01

TEST DESCRIPTION
F/A 18 Reynolds Number Effect Test
V = 20, 30, 40, 50, 60, 70 m/s;
Pitch = -15 to +15 deg, Roll = 0, 45, 90 deg
Tare coefficients generated on 19/05/05

TESTPLAN
C:\Documents and Settings\Adam Blandford\My Documents\ImPress One\Test Programs\FA18\Testplan Files\fs_01.xml
"ImPressOne Test Configuration Data"

PCU CONFIGURATION
PCU 1: crs 211, lrn 1, Pmax 1 psi
PCU 2: crs 217, lrn 2, Pmax 5 psi

SDU CONFIGURATION
FIU: crs 112

SCANNER CONFIGURATION
Scanner 1: Type DTC, 32 ports, Pmax 1, lrn 1

SETUP TABLE CONFIGURATION
Setup Table: 40 frames @ 25000 usec, 2 sets @ 2000 msec

PRESSURE PORT GROUP CONFIGURATION
static: 1 port(s); 101
dynamic: 1 port(s); 102
Station A: 13 port(s); 105-112, 124, 129-132
DISTRIBUTION LIST

“As per the Research Library’s Policy on electronic distribution of official series reports (http://web-vic.dsto.defence.gov.au/workareas/library/aboutlr/roles&policies/mission.htm) Unclassified (both Public Release and Limited), xxx-in-confidence and Restricted reports and their document data sheets will be sent by email through DRN to all recipients with Australian defence email accounts who are on the distribution list apart from the author(s) and the task sponsor(s). Other addressees and Libraries and Archives will also receive hardcopies.”

ImPressOne: A Pressure Display and Acquisition Program for the Low Speed Wind Tunnel at DSTO

Adam Blandford

AUSTRALIA

DEFENCE ORGANISATION

Task Sponsor

Chief, Air Vehicles Division (Infrastructure RDI Task) 1 Printed

S&T Program

Chief Defence Scientist 1
Deputy Chief Defence Scientist Policy 1
AS Science Corporate Management 1
Director General Science Policy Development 1
Counsellor Defence Science, London Doc Data Sheet
Counsellor Defence Science, Washington Doc Data Sheet
Scientific Adviser to MRDC, Washington Doc Data Sheet
Scientific Adviser Joint 1
Navy Scientific Adviser Doc Data Sht & Dist List
Scientific Adviser - Army Doc Data Sht & Dist List
Air Force Scientific Adviser 1
Scientific Adviser to the DMO Doc Data Sht & Dist List
Deputy Chief Defence Scientist Platform and Human Systems Doc Data Sht & Exec Summary

Research Leader – Jan Drobik, AVD Doc Data Sht & Dist List
Task Manager – Neil Matheson, AVD 2 printed
Author – Adam Blandford, AVD 3 Printed
V. Baskaran, Flight Systems, AVD 1 Printed
J. Clayton, Flight Systems, AVD 1 Printed
L. Erm, Flight Systems, AVD 1 Printed
R. Geddes, Flight Systems, AVD 1 Printed
M. Giacobello, Flight Systems, AVD 1 Printed
A. Gonzalez, Flight Systems, AVD 1 Printed
O. Holland, Flight Systems, AVD
P. Jacquemin, Flight Systems, AVD
S. Lam, Flight Systems, AVD
O. Levinski, Flight Systems, AVD
P. Manovski, Flight Systems, AVD
P. O’Connor, Flight Systems, AVD
C. Rider, Flight Systems, AVD

DSTO Library and Archives
Library Fishermans Bend
Library Edinburgh
Defence Archives

Capability Development Group
Director General Maritime Development
Director General Land Development
Director General Capability and Plans
Assistant Secretary Investment Analysis
Director Capability Plans and Programming

Chief Information Officer Group
Head Information Capability Management Division
Director General Australian Defence Simulation Office
AS Information Strategy and Futures
Director General Information Services

Strategy Group
Assistant Secretary Strategic Planning
Assistant Secretary International and Domestic Security Policy

Navy
Maritime Operational Analysis Centre, Building 89/90 Garden Island
Sydney NSW
Deputy Director (Operations)
Deputy Director (Analysis)
Director General Navy Capability, Performance and Plans, Navy Headquarters
Director General Navy Strategic Policy and Futures, Navy Headquarters

Air Force
SO (Science) - Headquarters Air Combat Group, RAAF Base, Williamtown NSW 2314
Staff Officer Science Surveillance and Response Group
Army

Australian National Coordination Officer ABCA (AS NCO ABCA), Land Warfare Development Sector, Puckapunyal
J86 (TCS GROUP), DJFHQ
SO (Science) - Land Headquarters (LHQ), Victoria Barracks NSW

JOINT OPERATIONS COMMAND

Director General Joint Operations
Chief of Staff Headquarters Joint Operations Command
Commandant ADF Warfare Centre
Director General Strategic Logistics

INTELLIGENCE AND SECURITY GROUP

AS Concepts, Capability and Resources
DGSTA, Defence Intelligence Organisation
Manager, Information Centre, Defence Intelligence Organisation
Director Advanced Capabilities

DEFENCE MATERIEL ORGANISATION

Deputy CEO
Head Aerospace Systems Division
Head Maritime Systems Division
Program Manager Air Warfare Destroyer
Guided Weapon & Explosive Ordnance Branch (GWEO)
CDR Joint Logistics Command

OTHER ORGANISATIONS

National Library of Australia
NASA (Canberra)
Library of New South Wales

UNIVERSITIES AND COLLEGES

Australian Defence Force Academy
Library
Head of Aerospace and Mechanical Engineering
Hargrave Library, Monash University
OUTSIDE AUSTRALIA

INTERNATIONAL DEFENCE INFORMATION CENTRES
US Defense Technical Information Center  1
UK Dstl Knowledge Services  1
Canada Defence Research Directorate R&D Knowledge & Information Management (DRDKIM)  1
NZ Defence Information Centre  1

ABSTRACTING AND INFORMATION ORGANISATIONS
Library, Chemical Abstracts Reference Service  1
Engineering Societies Library, US  1
Materials Information, Cambridge Scientific Abstracts, US  1
Documents Librarian, The Center for Research Libraries, US  1

INFORMATION EXCHANGE AGREEMENT PARTNERS
National Aerospace Laboratory, Japan  1
National Aerospace Laboratory, Netherlands  1

SPARES  5 Printed

Total number of copies:  64 Printed: 26 PDF: 38
**DEFENCE SCIENCE AND TECHNOLOGY ORGANISATION**

**DOCUMENT CONTROL DATA**

<table>
<thead>
<tr>
<th>1. PRIVACY MARKING/CAVEAT (OF DOCUMENT)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>2. TITLE</th>
<th>ImPressOne: A Pressure Display and Acquisition Program for the Low Speed Wind Tunnel at DSTO</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>3. SECURITY CLASSIFICATION (FOR UNCLASSIFIED REPORTS THAT ARE LIMITED RELEASE USE (L) NEXT TO DOCUMENT CLASSIFICATION)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document</td>
</tr>
<tr>
<td>Title</td>
</tr>
<tr>
<td>Abstract</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4. AUTHOR(S)</th>
<th>Adam Blandford</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>5. CORPORATE AUTHOR</th>
<th>DSTO Defence Science and Technology Organisation 506 Lorimer St Fishermans Bend Victoria 3207 Australia</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>6a. DSTO NUMBER</th>
<th>DSTO-GD-0486</th>
</tr>
</thead>
<tbody>
<tr>
<td>6b. AR NUMBER</td>
<td>AR-013-808</td>
</tr>
<tr>
<td>6c. TYPE OF REPORT</td>
<td>Technical Report</td>
</tr>
<tr>
<td>7. DOCUMENT DATE</td>
<td>November 2005</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>8. FILE NUMBER</th>
<th>2005/1060240/1</th>
</tr>
</thead>
<tbody>
<tr>
<td>9. TASK NUMBER</td>
<td>RDI 04/182</td>
</tr>
<tr>
<td>10. TASK SPONSOR</td>
<td>CAVD</td>
</tr>
<tr>
<td>11. NO. OF PAGES</td>
<td>58</td>
</tr>
<tr>
<td>12. NO. OF REFERENCES</td>
<td>6</td>
</tr>
</tbody>
</table>

|-----------------------------|---------------------------------------------------------------|

<table>
<thead>
<tr>
<th>14. RELEASE AUTHORITY</th>
<th>Chief, Air Vehicles Division</th>
</tr>
</thead>
</table>

**15. SECONDARY RELEASE STATEMENT OF THIS DOCUMENT**

*Approved for public release*

OVERSEAS ENQUIRIES OUTSIDE STATED LIMITATIONS SHOULD BE REFERRED THROUGH DOCUMENT EXCHANGE, PO BOX 1500, EDINBURGH, SA 5111

<table>
<thead>
<tr>
<th>16. DELIBERATE ANNOUNCEMENT</th>
<th>No Limitations</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>17. CITATION IN OTHER DOCUMENTS</th>
<th>Yes</th>
</tr>
</thead>
</table>

**18. DSTO RESEARCH LIBRARY THESAURUS**


Wind tunnel tests, software tools, instrumentation

<table>
<thead>
<tr>
<th>19. ABSTRACT</th>
</tr>
</thead>
</table>

DSTO operates a low speed wind tunnel within the Air Vehicles Division of DSTO Melbourne. Airspeeds up to approximately 100 m/s can be produced in the empty test section which is 2.7 m wide by 2.1 m high. Acquisition and display of pressure distribution data over a model under test in the wind tunnel is important to the project manager and test engineer so they can monitor the results in near real time as the test progresses. A software package called ImPressOne was developed for this purpose giving a graphical display of the pressure and the ability to acquire pressure sets and save the data to file. This document provides details of the software and its operation. It also provides information on programming and development considerations of the software.